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1. Related tools

o Wallet software gitcoin-v1.23.1-win64-setup.exe
e Mining software gtc-miner.exe

Download the latest version of QitCoin Core from Official Website and Unzip the file

Qitchain Network

Q0000000

2. Qitcoin Core Installation

Step 1. Click next for Installation

(&) Qitcoin Core (64-bit) Setup — o

Welcome to the Qitcoin Core (64-bit)
Setup Wizard

This wizard will guide you through the installation of Qitcoin
Core (54-bit).

It is recommended that vou dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.



http://www.qitchain.net/

Step 2. Main program path C:\Program Files\Qitcoin by default.

Welcome to Qitcon Core.

As this is the first time the program is launched, you can choose
where Qitcoin Core will store its data.

Qitcoin Core will download and store a copy of the Qitcoin block chain.
At least 4 GB of data will be stored in this drectory, and it will grow
over time. The wallet will also be stored in this drectory.

Q Use the default data directory
() Use a custom data drectory:

C: ' -0 2 t2 \Roaming \gitcoin
301 GB of free space avaiable,
A new data directory will be created.

When you dick OK, Qitcoin Core will begin to download and process
the full Qitcoin block chain (3GB) starting with the earliest transactions
in 2018 when Qitcon initially launched.

| ) Discard blocks after verification, except most recent 2 GB (prune)
This initial synchronisation is very demanding, and may expose
hardware problems with your computer that had previously gone
unnoticed. Each time you run Qitcoin Core, it will continue
downloading where it left off,

(o ] conce
Step 3. Click-> Next to proceed

(=) Qitcoin Core (64-bit) Setup

— >
Choose Install Location
Choose the folder in which to install Qitcoin Core {64-bit). @ Q I C

Setup will install Qitcoin Core {(64-bit) in the following folder. To install in a different folder,
dick Browse and select another folder. Click Mext to continue.

Destination Folder

C:\Program FilesYQitooin | | Browse...

Space required: 54.6MB
Space available: 45.9GB

<Back |[ Next> | | cancel

Step 4. Now click-> Install Button to start installation



(2} Qitcoin Core (B4-bit) Setup — S

Choose Start Menu Folder
Choose a Start Menu folder for the Qitcoin Core (&4-bit) l‘l Q I C
shortcuts.

Select the Start Menu folder in which you would like to create the program's shortcuts. You
can also enter a name to create a new folder.

|

Accessibility -~
AcCcessories

Administrative Tools

Apowersoft

Chrome Apps

Discord Inc

doPDF 7

Grammarly

HP

Huion Tablet

KMSpico "
[]oo not create shortouts

<sack Cane

Step 5. During installation you can wait a few second to complete installation of the Qitcoin Core.

(£) Qitcoin Core (64-bit) Setup —

Installation Complete
Setup was completed successfully. ﬁ Q I C

Completed

Output folder: C:\Program Files\Qitcoindoc #n
Output folder: C:\Program Files\Qitcoin

Output folder: C:\Program Files\Qitcoin

Created uninstaller: C:\Program Files\Qitcoinuninstall.exe

Create folder: C:\sers\Digital Code 3\AppData\FoamingMicrosoft\Windows\Start M. ..
Create shortout: C:Ylsers\Digital Code 3VappDataiRoamingicrosoft\Windows\Start.. .
Create shortout: C:Ylsers\Digital Code 3VAppData'RoamingMicrosoft\Windows\Start. . .
Create shortout: C:Ylsers\Digital Code 3VappDataiRoamingicrosoft\Wwindows\Start.. .
Create shortout: C:YUsers\Digital Code 3VAppData'RoamingMicrosoftiWindows\Start. . .
Completed -

Step 6. Once you reached the last step you need to click -> Finish Button



(2) Qitcoin Core (64-bit) Setup —

Completing the Qitcoin Core (64-bit)
Setup Wizard

Qitcoin Core {(64-bit) has been installed on your computer.

Click Finish to dose this wizard.

Run Qitcoin Core {64-bit)

3. Create an account and wallet

Step 1. [File] - [Create Wallet]

(@) Qitcoin Core — O >
File Settings Window Help
Create Wallet... Receive [ Transactions

Open Wallet 4

Close Wallet... Recent transactions

Open URL...
Backup Wallet...
Sign message...

Verify message...

Exit Ctrl+Q

Create a new wallet QTC & HOD ﬁ <

Step 2. Enter Wallet name as you choice. Accounts are divided into encrypted and blank wallets



e Encrypted wallet: Your password will be used to encrypt the wallet
e Blank wallet: There is no password, you can set it later. The place to set the password is in [
Settings)] ----> [Encrypted Wallet]

@ Owerview A> Send & Receive 8 Transactions

Balances Recent transactions
Available:  0.00000000 QTC

Pending: 0.00000000 QTC
(2) Create Wallet ? >

Total: 0.00000000 QTC
Wallet Mame |

a Encrypt Wallet

) Make Blank Wallet

Create Cancel
\ qQTC @ Ho S oF
Step 3. Create New Passphrase Password. Click ----> [0OK]
=
ﬁ Overview A} Send & Receive E Transactions
Balances Recent transactions

Available:  0.00000000 OTC

=) Encrypt wallet I4 =
Pending: 0.000( — P
Total: 0.000( Enter the new passphrase for the wallet.

Flease use a passphrase of ten or more random characters, or eight or more words.

Mew passphrase |

Repeat new passphrase

"] Show passphrase
Ok Cancel

QTC G HD 32 F




Step 4. The password must be kept in mind. If the password is forgotten, the assets of this wallet will be

lost forever.

@ QOverview Q Send g Receive [ Transactions

Balances Recent transactions

Available:  0.00000000 OTC

o)
Pending:  0.0000 —
- ) Confirm wallet encryption >
Total: 0.000( Enter t b3 il
Please . -
‘Warning: If you encrypt your wallet and lose your passphrase, you will LOSE ALL
OF YOUR QTCs!
Mew pz Are you sure you wish to encrypt your wallet?

Repeal

QK Cancel

QTC & HO o o

Step 5. Once the password do not feel safe, you can modify, but you must use the original password,

and then set a new password.

(=) Qitcoin Core - gitcoin
File Settings Window Help

Encrypt Wallet... ive [ Transactions Wallet: | gitcoin hd
Change Passphrase...

Ba Options... Recent transactions

Available: 0.00000000 QTC

Pending: 0.00000000 QTC

Total: 0.00000000 QTC

Change the passphrase used for wallet encryption Qrc & HD 2 o

Step 6. Use a wallet



e Open wallet

(&) Qitcoin Core - gitchain — ] =
File Settings Window Help

Create Wallet... |Receive B3 Transactions Wwallet:  gitchainl hd
Open Wallet > [default wallet]
Close Wallet... Qitcoini Recent transactions
Qitcoin
Open URL... 11/4/2021 16:49 -0.00005520 QTC
Backup Wallet RN 0
= ) : {3CPNPS 2JZgLcChIwTyufYhUi Lig<4iLVYp)
Sign message... gitchain
Verify message... gitcoin NO 11/4/2021 12:59 +1.00000000 QTC

Exit Ctrl+C

qQrc @ Ho 5 oF

o After opening the wallet, the current wallet ownership will not change. It can be understood as
importing this wallet. Which wallet is actually affected by the current interface is triggered by
the selector in the upper right corner.

(2} Qitcoin Core - Qitcoin — O =
File Settings Window Help

ﬁ Owerview »Send & Receive 8 Transactions Wallet: Qitcoinl -

Balances Recent transactions

Available:  0.00000000 QTC

Pending: 0.00000000 QTC

Total: 0.00000000 QTC

QTC @ HO o of



For example, if it is the default wallet, select your wallet (Qitchainl) when opening the wallet. The
current interface still displays the balance of the default wallet by default. To see the balance of
Qitchainl, you need to switch to the wallet list in the upper right corner.

e C(Close wallet

Close the current wallet, and it will disappear from the wallet selection list in the upper right corner.
Closing the wallet is not deleting the wallet.

Step 7. Backup wallet

o Next, we need to back up our wallet files. This action is very important. It is recommended to do
this. Backup wallet process: open the wallet [window] ---> [information] interface

=} Qitcoin Core - Qitcoind — [} >
File Settings Window Help
@ Crverview Minimize Ctrl+ M actions wWallet: Qitcoinl -

Sending addresses
Balances Receiving addresses Recent transactions

Available: 0.0 -
Information

Pending: 0. Console
Metwork Traffic
Total: 0.( Peers
QTC & HD 52 of
2} Debug window — [} s
Information Console Metwork Traffic Peers
General
Client version w1.23.7.0-5chbde 56 25-dirty
User Agent fQitcoin: 1.23.7f
Using BerkeleyDB wersion Berkeley DB 4.8.30: {april 9, 2010)
Datadir C:\Users'y AppData\Roaming Ygitcoin
Blocksdir C:\Users'y ‘appDataiRoaming gitcoin\blocks
Startup time Fri Mov 19 13:55:45 2021
Network
Mame main
Mumber of connections 9 (In: 0 Out: 9)
Block chain
Current number of blocks 83437
Last block time SatMow 20 02:52:14 2021

Memory Pool

Debug leg fil
Current number of transactions 0 g [ OURE

&2 Open

Memory usage 0.06 KB



C:\Users\"YOUR USERNAME"\AppData\Roaming\gitcoin

Here is the storage directory of our wallet data files

C:\Users\"YOUR USERNAME"\AppData\Roaming\gitcoin

Adding wallets after this path is the storage path of our wallet file

I 4 = | wallets

E [THl Preview pane

Mavigation [TH Details pane

Share

i 10

pane =
Panes
. ~ ~ <<
> Attachments

> @M Desktop

» | Documents
> Eurcpass

] Pusic

> P4 Pictures

~ [l This PC
> |l Desktop
» | Documents
> b Downloads
> ) Music
> Pictures

9items

[ Extra large icons

View

[ Large icons

Medium icons 38 Small icons - [Ti] Add columns =
— — Sort
List by~ Kt Size all columns to fit Hidden items
Layout Current view
» AppData *» Roaming > gitcoin > wallets ~ Search wallets
~

| Mame Date modified Type

database 11/19/2021 1:55 PM File folder

qitchaini File folder

gitcoin 1171372027 2:41 AM File folder

Qitcoin 117172021 2:56 PM File folder

Qitcoin2 10/23/2021 6:23 AM File folder

D walletlock
El db
[T uooo2o.dat

D wallet.dat

101

111

1] Group by ~

972021 1:531 AM WALLETLOCK File
972021 1:51 AM Text Document
2021 2:57 PM DAT File

9/2021 1:58 PM DAT File

Item check boxes

[1 File name extensions

Hide selected Options

items

Show/hide

Size

E=.

e The following *.dat files are stored from other wallets, as long as they are placed under this
directory, they can be seen in [File]->[Open Wallet]

(=) Qitcoin Core - Qitcain

File Settings Window Help
Create Wallet... |Recewe B Transactions
Open Wallet * [default wallet]
Close Wallet... Qitcoinl
Open URL... Qitcoin
Backup Wallet... LIS
i T gitchaini
gitcoin

Verify message...

Exit Ctrl+C

Recent transactions

wallet: Qitcoinl -

QTC & HO oF° o




e You can also operate directly in [File] > [Backup Wallet]
e  But the wallet backed up by the backup wallet is the wallet currently selected in the wallet list in

the upper right corner, such as:

(=) Qitcain Core - gitchainl

File Settings Window Help
Create Wallet...
Open Wallet L4
Close Wallet...

Receive [ Transactions

Open URI... .
Backup Wallet... I'

Sign message...

Verify message...

Exit Ctrl+Cy

Backup wallet to another location

- O x

i Wallet: ' gitchaini -

__Recent transactions

11212021 00:55 -0.00005520 QTC
(3CPNPS 21ZgleChIwTyufYhUi Lig<iLvyp)

’ 11/4/2021 16:49 -0.00005520 QTC

(3CPMNPS21ZgLcChIwTyufYhLi Gis4iLVYp)

N\) 11/4/2021 12:59 +1.00000000 QTC

QTC @ HD 3R of

The above is the completion of the wallet registration, encryption and backup. Please be sure to save your
walletfile. It is recommended to find a clean and non-toxic U disk to store this file. In the blockchain world,
the private key is more important than anything else. It is recommended that the wallet password be
copied and backed up in a safe place. At the same time, the following suggestions are given:

1. The wallet must be backed up, and there are multiple ways. It is best to store several safe virus-

free U disks or computers.

2. The brain generates a mining accounts passwords and ID numbers must remember to save.
3. If you have a surprising number of QTCs, please prepare a computer that is absolutely clean,
non-toxic and non-trojan horse, which is not used very much, specifically for transfer

transactions and so on.

4. Don't hand over the *.dat files to others casually.
5. Itis recommended to copy the wallet encryption password by hand to paper and put it in a safe
place. It is recommended not to store it on a computer.



4. P disk
Before hard disk mining starts, there is a P disk process. What is P disk?

The full name of the so-called P disk is Plotting hard disk, which is to create a Plot file in the hard disk,
and you will also create something called a random number. Random numbers are generated by
repeatedly hashing data, including your account ID and so on. If you allocate more hard disk space for
Plotting, then you store more random numbers. The larger the hard disk capacity, the more random
numbers stored in the hard disk, and the greater the probability of mining QTC.

Step 1. Get hashrate ID

We open the QTC wallet and click [Help]->[Generate Hash Account]->Here must be saved. This hashrate
ID is your hashrate ID. The ID is composed of numbers. The brain password is generally composed of 12
English words. It is as important as the mnemonic phrase of the wallet. Remember to keep the hashrate
ID and brain password! Pay attention to the copy backup!

(G

@ Owerview ﬁD Send g Receive [ Transactions wallet: | Qitcoinl -

Balances Recent transactions

Available:  0.00000000 QTC
Pending: 0.00000000 QTC

\3} Generate plotting account »
Total: 000000000 QT

This account is randomly generated, please save it. Loss will make plotting data
invalid.
Passphrase: dragon today grab pie

Plotter ID: 13286892081590739426

ok |

QTc & HO 2% o
Step 2. Start Plot hard disk
Open the gtc-miner.exe mining integration software in the gtc-miner directory.

Click the [P Disk] button after opening the software
Select the path of the P drive

Fill in the previously generated hashrate ID

4. Confirm the capacity of the P disk

wnN e

As shown below:



| @ aTC Miner

Path (&) Plot — ] *
1
Save Path  Fiplot
2 Plot ID 13286892081590739426
Capacity 10'31 GB
Cache size 2
Threads 4
(3) Start
Information
Address http/flocalhost:3332 Save Capacity: 0.0000 TiB
Job: 83447 Information: Scan ...
Language English ~
e Then wait for the P drive to complete.
(@) Plot — O
Save Path F\plot
Plot I 13286892031590789426
Capacity |100 GE

Cachesize 8

Threads 4

Waiting ...

Free

Add




(=) Plot — O >

Path Free

Save Path Fi\plot

Plot D 13286892081590789426

Capacity 100 GB

Cachesize 8

Threads 4
Completed
Information
Address httpe/flocalhost:3332 Save Capacity: 0.0000 TiB Plot
Job: 83851 Infermation: Scan ... e

Language English -

e In this way, we have completed the Plot hard disk, and after the P is completed, we can start
mining. (Hint: The hard disk after the plot is finished will be displayed in red, and the disk is full
because it is filled with the encryption algorithm POC.

5. Mining
Step 1. Mining in SOLO mode

e Open the mining wallet program Qitcoin Core (mining, 64-bit)

Q

Qitcoin Core e

\(’:) Qitcoin Core (64-bit)

| @ Qitcoin Core (mining, 64-bit) I

Qitcoin Core (testnet, 64-bit)

(’ Uninstall Qitcoin Core (64-bit)



e C(Click the [Add] button to add the drive letter directory of the completed P drive

@ aTC Miner =
@ E2aEEF () w
“— > w I i« Local Disk (F) » plot o (&) Search plot Fel
Organize « MNew folder = - (7]
> [ Documents MName - Date modified Type
> b Downloads Mo iterns match your search.
> ) Music
> PN Pictures
> [ Videos
5 %= Local Disk (C:)
> === Local Disk (E:)
> === Local Disk (F:)
[ .
Folder: plot
© ‘ Select Folder l Cancel Plot
Jomn: 383 E———— = Add
Language English ~ I-\'-l"/-l
e Add all the drive letter directories in turn, as shown in the figure below
(&) OTC Miner — O
Path Capacity Free
Fplot 0.0977 TiB 152.77 GB
Information
Address httpi//localhost:3332 Save Capacity: 0.0977 TiB Plot

Job: 83853 Information: Scan ...

Language English o



Step 2. Bind the wallet address

Note: Mining needs to bind the hashrate ID to the wallet address to be able to mine normally.
e Click the [Send] button - select [Bind to] = [Enter ID] = [Enter Passphrase] = [Send]

(=) Qitcoin Core - gitchain
File Settings ‘Window Help

@ Ov?’r_?_e\\.m ﬁ Send g Receive a Transactions
LY )

Wallet: gitchainl -

cTazpyzEhUaRs) E @

Bind To: Enter a Qitcoin address (e.g. 3LXluGfalmeLG]Egy7a

Plotter:  Enter your plotter passphrase or bind hex data

Alive Time: 24 hours {430 blocks)

Balance: 0.799889360 QTC

QTC @& HD 3% of

Bind to - A send Check/Generate
Pawv to L

Pt
[Bind to ____ -1y
g

Foint to =
Staking to

e Select or write wallet ID to bind:

@ Overview » Send g Receive s Transactions

Bind To: Enter a Qitcoin address (e.g.

LB
? =

@ Choose the address to receive coins with T

A These are your Qitcoin addresses for receiving payments. Use the 'Create new receiving address' button in the receive tab to create new addresses. -

Enter address or label to search

3CPHNPS2JZgLoChIwTyufYhUiljig4iLVYp|

nQrTc

Bin

| )

~
y Choose

& Copy &
)

e Note: Now enter the passphrase and click the [Check/Generate] button to check whether the

bound hashrate ID is correct



Wallet: gitchaini -

@ Cverview ¢ Send g Receive E Transactions

e e

Bind To: SCENPS2JZgLoChIwlyufYhUiljig4ilvyp

Plotter: FRFRRRRF RN RN RN RN R RN RN R RN RN R RN RN RN RN RN R R R RN R RN RN RN R RN R R RN RN RN RN R RN

* -

Alive Time: | 24 hours (480 b@ Bind plotter
o Bind 13286892081590789426 to 3CPNPS2JZgLcChIwTyufYhUilji84iLVYp

You can copy and send below signature bind data to
3CPNPS2ZgLcChIwTyufYhUilji84iLVYp owner:

0410000000047 49010020 760742543 8f8c60df22c091f2d3fdeeh ceB22 c73Th44cdD
Tf42692a5d6262405eb257f7420c52ff350ef251 5c3edfbcalaalec30976f7Fc051 cdf78
f57ab50d2cd48c9c5e811fb8dc49dal23853a748259574d6d 13afbdcecfe2e53f98fF196

Copy bind data Close

Bind to i A2 Send Chedk/Generate Balance: 0.793338960 QTC

Qrc @ HO 38

e After confirming that the above information is correct, click the [Send] button to complete the

wallet address binding.

Wallet: gitchainl -

G} Owverview ¢ Send g Receive a Transactions

DBe e

Bind To: 3CPNPS32JZgLlcChiwTyuf¥hUiljis4ilVip

Plotter: eesss
—— () Unlock wallet ? >
Alive Time: | 24 ha | -
This operation needs your wallet passphrase to unlock the wallet.
Enter passphrase |
| show passphrase
OK Cancel

Bind to - A Send Check/Generate Balance: 0.79988960 QTC

qQrC @& HO 28 of



@ Qitcoin Core - gitchain

@ verview @Send g Receive E Transactions

Wallet:  gitchainl -

Bind To: 3JCENPS2JZgLoChdwlvuiThUiljis4ilvip

BRSNS

Flotter: wessss

Alive Time: | 24 hours (480 b

o Are you sure you want to send?

13286892081590789426 bind to 3CPNPS21ZgLcChlw TyufYhUiljiB4iLvVyYp The
operation will lock 0.10000000 QTC. You can unbind later, and the locked
amount will be returned to this address,

(&) Confirm send coins X

Transaction fee (0.381 kB): 0.00005520 QTC

Total Amount: 0.10005520 QTC
(=100.05520 mQTC or 100055.20 bits or 10005520 Satoshi (sat))

Yes Cancel

Bind to - £ send Check/Generate

(&) Qitcoin Core - gitchainl
File Settings Window Help

@ Overview ¢ Send & Receive 5 Transactions

* |Enter address, transaction id, or label to search

Balance: 0.89994480 QTC

QrC of Ho o <
— O >
Wallet: gitchainl -

Min amount

Step 3. Pledge mining

Type Label Amount (QTC) =
(3CPNPS2ZgLcChiwTyufYhUiljis4ilVYp)
f 117472021 16:49 Binded plotter ’ (3CPMNPSAZgLcChlwTyufYhUiljigdil\VYp) -0.00005520
F 117472021 12:59 Received with *H (3CPMNPSAZgLcChlwTyufYhUiljigdilVyp) 1.00000000
v
= Export

Qca R g

Note: Pledged mining can obtain 100% of the income of the computing power, and only 5% of the

income without pledge.



Click [Send] = select the [Point to] tab = fill in the wallet receiving address in the (Point to:)

text box = enter the amount to be pledged - select the lock time period - click [Send] to

complete pledge mining.

(2} Qitcoin Core - gitchaini

— (] =
File Settings Window Help
@ Overview_g Receive E Transactions Wallet:  gitchainl -
|/] J
Point To: Enter a Qitcoin address (=.g TazpyzEhUaRs) E E
Label: Enter alabel for this address to add it to your address book
Amournt: = |gTe = | [ Subtract fee from amount Use available balance
Lock Blocks: 51 weeks (172300 blocks) -
| Transaction Fee: 0.00020000 QTC/kB Choose... Warning: Fee estimation is currently not possible.
A send

(&) Qitcoin Core - gitchain1
File  Settings ‘Window  Help
@ Overview ¢ Send g Receive E Transactions

1

Balance: 0.79988960 QTC

Qrc & Ho 3R

Wallet:  gitchainl -

— PointTo:  3640FXd2InbpgHOsDRxTHekososMZsnUzZ

Label:  wallet3
— —
2 Amount:

DeE e

0.00500000| 3| QTC -

Lock Blocks: 51 weeks (172800 blocks)
7 .3- kY

(3)

[ Subtract fee from amount

Use available balance

-

Transaction Fee: 0.00020000 QTC/kE Choose...

Warning: Fee estimation is currently not possible.

Pointto  + > send

This completes the pledge mining operation.

Step 4. Staking ranking rewards

Balance: 0. 79988960 QTC

QTC @ Ho 2 F



Note: Participating in the top 10 rankings of Staking in the world can get 20% of the dividend rewards for
miners in mining. It should be noted that if the authorized amount is less than the amount of the
address in the last ranking, you will not be able to participate in the Staking dividend.

=) Qitcoin Core - gitchainl
q

File Settings Window Help

Q Overview ﬁ Send g Receive 8 Transactions
10

=

Wallet: gitchainl -

Staking To: Enter a Qitcoin address (e.g. 3LEluGfalmélGjégyTaFlcTazpyzEhUaRs) E % ®

Label: Enter a label for this address to add it to your address book
Amount: = [QTC w | [] Subtract fee from amount

Use available balance
Lock Blocks: | 51 weeks (172800 blocks)

-

Transaction Fee: 0.00020000 QTC/kE Choose... Warning: Fee estimation is currently not possible.
Staking to ¥ A Send Balance: 0.79988960 QTC
Pay to
Bind to 'R HE
| Paint tn =y Qre @ Ho NS g
(&) Qitcoin Core - gitchain1 — O X
File Settings Window Help
@ Overview ﬁ Send g Receive [ Transactions Wallet: | gitchain1 v
P
\'JENTER RECIVING ID
Staking To:  3640FEd2JnbpgHOsDRxTNekososMZsnUzZ £H8®

Label:  wallet3

ount: 0.00300000 5| QTC v | [_] Subtract fee from amount Use available balance

Lock Blocks: 51 weeks {172800 blocks)

-

Transaction Fee: 0.00020000 QTC/kB Choose... Warning: Fee estimation is currently not possible.

Staking to &> send ® Balance: 0. 79985960 QTC

crrca'-'n:ﬁe?_




6. QTC commonly used commands
e help: List commands or get command help
Command format: help ("command")
e backupwallet: safely copy wallet.dat to the target path
Command format: backupwallet "destination"
For example: backupwallet "C:\aaa"
o dumpprivkey: display the private key corresponding to the address
Command format: dumpprivkey "address"
e dumpwallet: export all wallets to a file
Command format: dumpwallet "filename"
e getbalance: return the account balance
Command format: getbalance ("dummy" minconf include_watchonly avoid_reuse)
e getbalances: return the balances of all objects in the account
Command format: getbalances
Returns an object with all balances in QTC.
e getmininginfo: return an object containing mining related information
Command format: getmininginfo
Command description: Returns a json object containing mining-related information.
e getpeerinfo: return the data of each connected node
Command format: getpeerinfo
Command description: Returns data about each connected network node as a json array of objects.
e Importprivkey: add the private key to your wallet
Command format: importprivkey "privkey" ("label" rescan)

Command description: Adds a private key (as returned by dumpprivkey) to your wallet. Requires a new
wallet backup.

e Walletpassphrase: Store the wallet decryption key in the memory for <timeout> seconds.
Command format: walletpassphrase "passphrase" timeout

Command description: Stores the wallet decryption key in memory for'timeout' seconds.



